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Last Time: Tonight:

« Assembly drawings « Shared data
» X-sec  Copied Geometry
» Exploded « Component Operations
e Tables e Family Tables
« BOM
* Inclusions

» Simplified Reps

» Notes on Critical to Function
Drawings

* Modeling text

» Color and Appearance Texture
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Shared Data - Copied Geometry

Component and assembly data can be shared among var  ious files
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EXERCISE - Shared Data

* File > Open
» Select .stp file type
» Select mouse.stp

e File > New > Part > button
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EXERCISE - Shared Data

* In button.prt

* Insert > Shared Data

> Copy Geometry
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EXERCISE - Shared Data

» Uncheck Published

Geometry only
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EXERCISE - Shared Data

» Select Reference

* From the taskbar, select
the Pro/E window with the

mouse surface.....
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EXERCISE - Shared Data

e ...Click on the outer surface
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EXERCISE - Shared Data

button.prt

» Select Surface Sets
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EXERCISE - Shared Data

[} I n m 0 u Se . p rt’ Se I e Ct th e B MOUSE (Active) - Pro/ENGINEER Education Edition
surface defining the =

button

* MMB when done
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EXERCISE - Shared Data

* This file now is linked to

previous file

» Try creating part files
for the top and bottom of &|=|

the body as well
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Family Tables

* In many cases mechanical components have very similar constructions

» Family Tables can create multiple “instances” of components sharing common
features

sockel
round head set ‘socket head
head torx screw  cap screw

slotted  screw  (sss)

socket  sockethead  hex
shoulder button screw  cap scre
- screw (shbs)

http://www.curiousinventor.com/images/guides/ . . _
metal_working/screws/machine_screws3.jpg http://www.projectholds.com/images/SS38ST.jpg




EXERCISE - Family Tables

* From the Supporting
Materials page download
stuff for tonight :

* shoy
Pselec
© Shaded mode! wil be displaved
® Hidden lines will sppear in grey,

* File > Open > shcs.prt
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EXERCISE - Fami

 Tools > Family Table...

e This will launch the
Family Table definition
dialog

ly Tables

SHCS Rev: /110 (Active) itws:/iegr-prd-eng-01/learn/SHCS.PRT -
File Edit Yew Insert Anslysis Info Applications

DeLDBE »

e 5elect items such as Dimensions, Geometry Tolerances, |

a
i Relations.

Barameters.

S Enter value (negative not alowed)
# SHCS has been cleared

® SHCS has not been saved because it hasn't changed,

AREE

Show > || Settings ~
Feat
) SHCS.FRT
L £7 RIGHT 1
£7 TP z
/7 FRONT 3
2 050 4
i '-‘ A1 32
i Extuds 1 3
o) Extrude 2 7
&) Extude 3 8
g
=) Round 1 0
< Chamtsr 2 1
|77 Cosmelicid 2843 | 12
13
= Round 3 i
& InseitHere
< >

reate/modfy part famly table.

Designate, .
Brogram
UDF Library...

Model Player
Assembly Settings

E24 Play Tral Training File,

- 2l Distribured Computing

Projuleb Link
() Mapkeys
Flaating Modules
Auziliary Applications
% Environment.

Server Registry...

Customize Sereen
" Clear History
Options

Relations. ..

Parameters. ..

L
LIDF Librars..,
Model Blaver. ..
Eille  Edit Insert Tools
ILaalk Ir SHCS v = EIII ﬁjﬁ

This model cunrently has no family table design variations.

Select (1] to add dimensional or feature parameter columns to the table.

Select zm to define instance model rows as design variations of the current model.
substituting different values in the cells for those parameters in each instance.

Smat

K3




EXERCISE - Family Tables

* We will build a table in this dialog that defines the family of components

» The columns of the table are comprised of the parameters that define
the components

« Each row will be a separate instance of the family, defining a specific
set of parameter values

@ Family Table :SHCS
File Edit Insert Tools

L4
EIEEI

=
o+

Thiz model currently has no family table design variations.
Select EEIE to add dimenzional or feature parameter columnsz to the table.
Select EII! to define instance model rows as design vanations of the current model.

substituting different values in the cells for those parameters in each instance.




EXERCISE ) Famlly Tables @ Family Table :SHCS
File Edit Insert Tools

» Select the “Add/Delete the Table S
Columns” button on the Family Setec T to ot dmensioat o fentete otaneret cotamns {0 the bl
Table dlalog bOX Select EII! to define in 8 Family Items, Generic - SHCS

substituting different v

v o Of

EEX]

. . [tems Filker
» Another dialog will launch to select ; |
the dimensions we are concerned
with

[+]

Add ltem
{*) Dimenzion () Group
() Feature () Parameter () Pattern T able
) Merge Part ) Fef Model ) Other

[ Ok, ] [ Eancel]
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EXERCISE - Family Tables

 Select the following
dimensions:
» Head height (.250)
» Head diameter (.375)
* Hex width (.188)

» Hex depth (.120)
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P
EXERCISE - Family Tables

 Select the following
dimensions:
» Thread major dia. (.250)
 Shaft length (1.500)
» Thread length (1.000)

* Thread minor dia. (.191)
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EXERCISE - Family Tables

* Click on OK on the selection dialog

» Take a look at the Family Table dialog to see the
dimensions that available

B Family Table :SHCS

File Edit Insert Tools

B=1ES

WLaok Iry SHES EII! Eﬂﬁ B 5
Ty Istance Mame d240 d241 d245 d244 d243 d242 d255 d256
0.250 0.375 0133 0120 0250000 1.500000 1.000000 0131000

LCancel




EXERCISE - Family Tables

* Click on the “Insert a new instant at the selected row” button
* Note that a new row is created with blank values
 Name the new instance “P250-20 X 1P500”

» Be careful that the name is accepted

» The instance naming standard is very restrictive

& Family Table :SHCS

File Edit Insert Tools
Laok I SHCS vl T % By Ry @ 6o Ba [ [T
Tope  Instance Name 4240 d241 d245 d244 4243 d242 d255 4256
N igHCS | 0250 0.375 0188 0120 0.250 150 1.00 0191
‘ P260-20_%_1PS00 | 0.250 0,375 0188 0120 0.250 1.00 0.50 0191




EXERCISE - Family Tables

* Click on the “Insert a new instant at the selected row” button
» Note that a new row is created with blank values
 Name the new instance “P250-20 X 1P500”

» Be careful that the name is accepted

» The instance naming standard is very restrictive

» Copy all the values from the previous row into the new row

® Family Table :SHCS

Eile Edit Insett Tools
Lok Ir| SHCS v & 7 S @Etp EZRNEEE]

Tz Instance Mame d240 d24 d245 d244 d243 d242 4255 d256

{SHCS | 0.250 0.375 0188 0120 0.250 1.50 1.00 0191
‘ P250-20_¥_1P500 | 0.250 0.375 01gs 0120 0.250 1.50 1.00 01




EXERCISE - Family Tables

* In Family Table dialog,
Tools > Verify

] SHCS Rev: /M0 (Active) itws://egr-prd-eng-01/learn/SHCS.PRT.1 - Pro/ENGINEER

. . Fle Edt Vew Insert Anshysis Info Applications Took ANSYS 11 o Help -
* N Famlly Tree dlalog, DB B6E siek: W Ar®RansRom Bold ) 4hA%k% WG o <
Click VERIFY button pREmERRT
BEEE
* This step verifies that =z °
the model we've just =
created will regenerate |[--i% |
QRDundT 10 s
correctly gL -
5 Round 3 14
& Inseit Here ﬁ,
« Verification Status should Vetlication Status I |
3
appear as “Success” F|success
.
: =
.
e C—




EXERCISE - Family Tables

Why did we just create the same thing again?

Generic or Base Instance — Everything
else is created from here, name indicates
what the family is and indicates where it
can be modified.

d242

B Family Table :SHCS

File Edit Insert Tools
b B G

d245

ILoak: In: SHCS

d255 d256

d244 d243

Inztance Marme d240 d241

_, ............... EI:I
F260-20_s_1P500 D, a0

013
013

1.00
1.00

1.50
1.50

0.250
0.250

0120
0120

0188
0188

0.375
0.375

Instance — The name given to this instance indicates
exactly what the instance is.

NOTE: This isn’'t necessary, but is a good practice the adds to the clarity of the family




EXERCISE - Family Tables

These column headings are not particularly helpful...

* Already there are too many columns to keep track of

* Let's add some clarity to make this more efficient going forward.....

B Family Table :SHCS EE]

File Edit Insert Tools

- e A = 3
ILDDk|nZEHES V! % P'm Eane
—— I —
Type Instance M d240 d241 d245 d244 d243 d242 d255 du
SHCS | 02580 0375 oTas U s 250 Rain) 1.00 0191
F250-20_s_1P500 | 0.250 0,375 01ag 0120 0.250 1.50 1.00 0.191




EXERCISE - Family Tables

Change the name of the key feature dimensions

& SHCS Rev: M0 (Active) itws:/egr-prd-eng-01/learn/SHCS.PRT - Pro/ENGINEER

CEE

« Edit the first solid
feature (Extrudel)

rface Finish or other features for editing.

® Hidden lines will appear in grey.
@ Select items such as Dimensians, Se

« Info > Switch e

Feat

vface Finich or ather Features for edting

() SHCS PRT

Dimensions e

/7 FRONT
".....‘ a1 -

-
7 Extrue 3

- < Chaner 1
- Round1

4
EWW'UPWN—‘

<) Chamtes 2 1
F Cosmetizid 2043 | 12

-5 Round 2 13
) Round 3 14
+ Insert Here

[Hssected T i
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EXERCISE - Family Tables

Change the name of the key feature dimensions

& SHCS Rev: /H0 (Active) ilws:/egr-prd-eng-01/learn/SHCS.PRT.1 - Pro/ENGINEER

He Edt Ven Insst & info Appli ols  atist el

* RMB on head height DEUBE 3G oo o RH - Or@aa@srtek 8E00 gikk vEODEEa

) Select items such as Dimensions, Sections, Datums, Features, Cosmetics for edting
@ Select Edt value or Properties to ed selected ftem(s)
@ select items such as Dimensions, Geometry Tolerances, Reference Dimensions for ediing

 Properties... BOEE

Show = | Settings ~ |

|3

o Feat#
() SHCS.PRT
1 1 H £7 RIGHT 1
* Click Dimension Text gee | =
£7 FRONT 3
B CS0 4
im 5 12
tab o Evtrude 1 g Nt T : l,./f@:ﬂ-i‘l
7 Extrude 2 7 rtrewmu;- ; g
i Entrude 3 8 rom st Section0
3 Chafer 1 9
Round 1 10
u : T g
e Enter “hea eight” In 1
- s " . Dimension Properties
“ Rownd 3 14 I ‘

the Name box
* Click OK

Set dimension ket

Ma | head_heigh] \ |
Prefis |

Fostfi | |

I li i
< I | 4 [ Move... J [ tove Tent... J Edit Attach... Text Symbal...
F dit Dimension Properties.

Fiestore Walues L ak, I [ Cancel J




EXERCISE - Family Tables

» Notice the name of the dimension

* Repeat this process for
* head _diameter
* hex_width
* hex_depth
 thread_major_dia
* shaft_length
* thread_length

 thread_minor_dia

& SHCS Rev: /H0+

7

AEED

n/SHCS.PRT.1 - Pro/ENGINEER

o

() SHCS.PRT
/7 RIGHT 1
£7 TOP 2
/7 FRONT 3
2050 4
Fm 5
- ] 6
) Extiuds 2 7
7 Extrude 3 8
< Charfer 1 E
5 Round 1 10
< Charfer 2 n
7 Cosmeticid 2843 | 12
< Rourd 2 13
% Round 3 4
# Inseit Here

)

al
&l
C—
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EXERCISE - Family Tables

* Go back and examine the Family Table
column headers (much better)

B Family Table :SHCS

File Edit Insert Tools

E, (mu] L I
lLosk nHCS v b B 7 & O oo 80 B0 M
T Insleres Wegie dz40 dz241 dz245 dz44 d243 dz242 d=55 dz256
o HEAD_HEIGHT ' HEAD _DIAMETER ' HEx WIDTH | HEX DEFTH  THREAD _MAIOR_DI&  SHAFT _LEMGTH ' THREAD _LEMGTH = THREAD MIMOR_DI&
SHCS | 0.250 0.375 n.1as 0120 0.250 1.50 1.00 0.191
P260-20_¥_1P500 | 0.250 0.375 n.1ag 0120 0.250 1.50 1.00 019




EXERCISE - Family Tables

» Create a new instance that has a 1.000 shaft_length and .750 thread_length
* Verify the instance
» Save the model

* Open the new instance

B Family Table :SHCS

File Edit Insert Tools

Look Irs [FHCS vio % BR B Twer S ET
dz40 d2d d245 d24d d243 dz42 d255 d256
g |l e HEAD_HEL.. HEAD_DIA.. HEX WIDTH HEX _DEPTH THREAD MAJO. SHAFT LENGTH' THREAD LEMG. THREAD MINOD..
SHCS | 0250 0.375 0188 0120 0.250 1.50 1.00 0191
P250-20_%_1P500 | 0.250 0.375 0188 0120 0.250 1.50 1.00 0191
P250-20_%_1P 0,250 0.375 0188 0120 0.250 1.00 0.75 0191




EXERCISE - Family Tables

Create a Family Table to show a spring in free, ins

* Open relief_valve.asm

Notice: the piston

interferes with the seal

because the spring

stack is shown at free

length

I RELIEF_YALYE {Active) - Pro/ENGINEER Education Edition

talled and compressed lengths

_[olx|
File Edit Wew Insert Analysis Info Applications Tools Mankin Window Help
3 . =] Og¥ Ued = = + AE

[CecoaqiocraaiiEens - |BrFnaandsten|e oo

4 ® k]
J"{Z r's";?(i:zH k‘)‘
o Select mating surface or datum plane on other part, d
o Select aligning surface ar datum plane on ather part,
* Component redefined successfully.

# Datum planes will not be displaved. j
B | 2| @ &l &
Show ~ ings ™ ;
10 | Settings | HD

' ~
STACK. ASM J':l
: —

\..

L
T

&

R e TR

1 selected [Sman = | g




F "..1,.
-l -

EXERCISE - Family Tables

[ ;::,_. rr ey ST
DIOWI1 | l'. H N1VEIrSITY

» Open belleville.prt

* Rename the following
dimensions as we did
previously

1D

« OD

« THICKNESS
e HEIGHT

HEGHT

BCB — Mar. 15, 2012 EN1740, S2012



EXERCISE - Family Tables

I BELLEYILLE {Active) - Pro/ENGINEER Education Edition I [=] 3]
- File Edit Wiew Insert Analysis Info  Applications Tools window Help
[ ]
Create a family table [DcEshe]roosbnbiEn |Hr2aals 660 o0
PRI
i
- has b d. — —
b Se I ect aI I th e @22:?:‘:&;55 silschzinDTni\;isions, Sections, Trajectories, Tolerances, Surface Finish or other Features faor editing flems et . .
g3 Select items such as Dimensions, Sections, Trajeckories, Tolerances, Surface Finish o other Features for editing d1.1D ¥ Dimension
d2, THICKMESS ™| Parameter
- . ] d3, HEIGHT I | Feature
dd4, an
dimensions mentioned on & |&|c| 5| e
Show = | Settings ~ | I | Fef Mol
. ™ Group
the last slide as columns | /=sue e =
L dp Tnsert Here THICKNESS
DD \ T
Vé _ W SEEEE
B Family Table :BELLEYILLE Ol
— Add ltem
File Edit Insert Tools | 5\ * Dimension £ Camponent " Group
" Feature " Parameter " Pattern Table
— b e e & &
Look Ir: EENIENE - W Bo [ 3% | == @§ Hy 6o o B EX R
Cancel
Type Instance Mame Common Mame ij[] ?EIICKNESS aali:IGHT g% i,
BELLEWILLE Belleville. prt 0.255000 0.018000 0.034000 0.500000 %
o8
Ok, Eﬂ- [pen LCancel |
Al -1l &




EXERCISE - Family Tables

» Go back to the relief valve.asm

as S e I I I b |y [ RELIEF_VALYE (Active) - Pro/ENGINEER Education Edition

] |
File Edit Wew Insert | Analysis Info  Applications Tools Manikin  ‘Window Help
o = 5 + RE T
e I, Drgvaalsrshe oo
L ] {wri)
M FooMy, vy [ Geometry » 2 Angle 1= pistance
P A ' {fad o]
* Measure the interference |z tans 20, » ] s
i . 0 N
® RELIEF WALVE has beer Mechanica Analysls”‘. o Diameter
&> Enter objzct whose old « User-Defined Analysis, ..
® Any old versions of REL1  Motion Analysis. ..

between the piston and the seal |- memm e
§n %l éﬁl Sensitivity Analysis. ..
Shaow ~ Settings ¥ Feasibility/Optimization, ..

Multi-Objective Design Study. ..
. I
(T RELIEF_YALYE.ASM
= Mode/CHECK
* Ar |aIyS|s > Measure > O e
[ HoUSING2 PRT ompare Assembly by feature

(] SEAL.PRT sy Saved Analysis
17 (] BELLEVILLE STACK g fide ay

D i Stan Ce - (1 PISTON.PRT e

Delete all

o i
20 Transfarm E Distance il

| SurbFSREVOLVE_
¥ Usze &z Plane
To | SurkFSEXTRUDE_
¥ Use &z Plane

Praojection
Direetion | Click here to add ite
» Select plane on piston <. ™ View Plane
L 55 I Cartezian j

» Select plane on seal WV Updsts

Diztance = 0.0530000

B | ouick =] /|5_DISTANCE

» Note the total interference is
.059in

ing State A

| [v| x|

Distance




EXERCISE - Family Tables

ucation Edition =1olx]
« From the measurement, we need  ur s e i o | | |
e
to lower the height of the Bellevilles == e et e |
Look In{ BELLEVILLE - Y B 7 o O ¢ oo 8 F T
from '034 to '0242 Type Instance Mame Carnman Marme i i &3 d4 | |
1D THICEMESS HEIGHT oD
BELLEWILLE biellzville. prt 0.255000 0.078000 0.034000 0.500000
. BLLW_IMSTLL belleville pri_IMST 255 014 0242 5
* Create a new Instance

“‘BLLV_INSTLL" o % open | Carcel|

G
o, - &
. : : ' ) s |
Copy all dimensions, except | - ?
for the height =
@
* Change height to .0242 .
* Verify instance and save part =
EC—




EXERCISE - Family Tables

* Return to the assembly

IE RELIEF_VALVE (Active) - Pro/ENGINEER Education Edition =]

File Edit ‘iew Insert Analysis Info Applications Tools Manikin  Window Help

* Create a Family Table (Tools > } D @‘%\J‘n o b Ty (02 42 -
gih%gw
Family Table...) LT =

EJMa instance selected.

[Ergmaamsteh|eoo T

2 ASM_DEF_CSYS
(] HOUSING.PRT
(] BELLEVILLE.FRT
[7] BELLEVILLE.FRT
() BELLEWILLE.PRT J -

[-[ ) BELLEVILLE.PRT .
[ [C] BELLEWTIIF.PRT
W N=atla (5 Family Table :RELIEF_YALYE

r
: : A o]l =

» Begin by adding columns e —— o |
RELIEF_VYALVE.ASM ".r %

e ~ |7

B[ HOUs: ) ‘
-7 SEALI File Edit Insert Tools N\ =
[ pisto 7l = - oy
Mgl Look In| RELIEF ‘ALYE J ‘ & B % & g G Bo  F m‘ o
i)
Thiz model cunrently has no family table design variations. :I
Select ﬁjé to add di ional or feature 1 to the table.

Select Eﬂ to define instance model rows as design variations of the cument model.

substituting different walues in the cells for those parameters in each instance.

QK BF’, Open Cancel
i




EXERCISE - Famlly Tables (ol x|

— ltems — Filter
k439, BELLEYILLE ™| Dimension
k420, BELLEWILLE ™| Farameter
 This time in the selection M BELLEVILLE I Feature
M382, BELLEVILLE ¥ Component
k381, BELLEVILLE
. ™ kerge Fart
dialog box, check the I~ Bt Mo
w Tools Mankin Window Help
[T Group

BREEEN A EnAAaEr

Component radio button

%= | o= |
» Select each Belleville
washer
SEENDE
* When prompted E
. — Add [kem
Se|eCt Slngle " Dimension = Component " Group
" Feature " Parameter ™ Pattern Table
" Merge Part " Fief Model £ Other

e Continue until all 6

] I Eancell
Bellevilles are selected 5
9

ISmart '” é




EXERCISE - Family Tables

* Create a new Instance with the add row button

= Family Table :RELIEF_¥ALYE - |EI|5|
Eile Edit Insert Tools
F:ELIEF_"-.-".L"-.L"-.-"E - ¥ B @ e @ (M 5o Be B [T
Ny 4
M43 M420 M M382 YEG M362
e ||lnslence bzme | oo fzms EELLEVILLE | BELLEVILLE | BELLEWVILLE | BELLEVILLE  |EELLEVILLE | BELLEVILLE
RELIEF_WALWE relief_walve. azm v Ny v Ny v N
I rcurvaLve L [relief_valve.asm_INST . . . . .

Ok é’- Open |

LCancel |




EXERCISE - Family Tables

» Select cell for the first Belleville instance

» Tools > Replace Using > Related model...

» Select the Belleville instance with the reduced height

* Repeat these steps for all 6 Bellevilles

IE Family Table :RELIEF_YALYE

File Edit Insert | Tools

=10l x|

R werif... m + = — |
Lack Ire| RELIEF_va SU 5 7% | T [ el
= ~ & Preview "g == i ey ) Eﬁ
B Lack § Unlack Instance
Type Inztance of Lock/ ) ) ) MdSEl M420
Absolute [ Relative Dimension Yalues BELLEWILLE BELLEWILLE
RELIEF_ Switch External References ko Instances, .. Y Y
RELIEF_ Configure Assembly Components. .. [ =

Replace Using

Sork 4

Showe Swstern Mass Properties

Eamily Mamber. ..

Related model. ..

Interchange Assembly. ..

|_'r:', Open

Open 5‘

——
ey v |21 <« MyDocuments » proe b inclass » family_table

v|‘y ISearch...
Bl Organize ~ (5 Yews ~ T Todk v I
-1
Comman Folders (71 bellevile. iR [ ST P e o "TT T |:||:|I:E: "t
9] In Session (S Gl st ™
7] Deskiop [T belleville_s

1 housing.prl

[ belleville. prt

53 My Documents X
. [0 housing2.p
% Wworking Directory 7 piston pat

AT KDl izt belleville: . prt
12 Favorites [0 relief_walve -
gee [ belleville_stack. asm
[ ) housing. prt
|| housing2. prt
File name: bllv_instlibelevile> pit Date modified: Preview =
File name: [ bilv_instlcbelleville>. prt Type | Pro/ENGINEER Files [, 7] 50ty =l
Falder Tree o

Open "I DpenRep...I Cancel |




EXERCISE - Family Tables

» Once all the Bellevilles are swapped out, Verify the model

[® Family Table :RELIEF_YALYE =10l x|
File Edit Insert | Tools [¥ Family Tree EI

AR erife.. = Tree Edit |
Ll In:IHELIEF_\-ff-‘- 2l verity. . Sl
St Presviem ==

m— Yerfication Status I

i3]
2o Lock [ Unlock Instance b 439 b4 382 b4 381 b 362
s ! Relative Dimension Yalues BELLEYII H:E"'EF-W‘L"‘ BELLEWILLE BELLEWILLE BELLEWILLE
- B RELIEF_*ALWE [IRtsls
RELIEF_ Switch External References to Instances. .. ki i v v
LIEF % Configure Assembly Components. .. BLLW_IM® BLLW_IMSTLL BLLW_IMNSTLL BLLY_IMSTLL
Replace Using F
Sark L4

Show System Mass Properties

Ok LCancel |
ol | i« i




EXERCISE - Family Tables

o After verifying the model, select Preview and make sure the interference is gone

[E PREVIEW x|

[= Family Table :RELIEF_YALYE

Eile Edit Insert Tools

_p—
Laok In:I RELIEF_VALVE - & FENE R Eﬂi’gﬁ] ao % F7
A N y A
Tupe Instance Name Comman Mame glléEEEVI LLE m ‘
RELIEF_WalvE relief_valve.asm N N
LIEF "#aLVE NS THREN=EEERE M) BLLY_IMSTLL BLLY_INSTLL

Ok Bq, Open |

Clipping Sate: A

Insta nex:RELIEF W ALVE INMST

Close




EXERCISE - Family Tables

» Save the generic and then open the instance

¥ File Open

e Y f - II:l « My Documentz » proe # oinclazz » fami

.JJJ Organize "Tr Toolz w
Cormmon Folders | belleville. prt

M| In Session " Bllv_instlls beleswville: . prt
m Dieskiop U1 belleville_stack. azm

) housing. prt
" ) housing2. prt

) piston.prt
System Formats T refief_valve.asm

b anikin Library [ hielief

% Favarntes (1 sealprt
) shes.prt

2 My Documents
ﬁ' Whorking Directarny

valve_instdrelief wvalve: asm




EXERCISE - Family Tables

[E RELIEF_¥ALVE_INST (Active) - Pro/ENGINEER Education Edition

e Done

File Edit Wiew Insert pgnalysis Info  Applications Tools Manikin  Window Help

= [=[ 3]

BEEEEEEEEE T e R e e == R =
|z A ts %5 x|

* Restoring instance RELIEF _WALVE_INST of RELIEF_WALVE ...

B | %] | &

Show |

Settings =

RELIEF _WALYE_INST.ASM
----- 7 BSM_RIGHT

----- 7 BSM_TOP

----- £F ASM_FRONT

----- A ASM_DEF_CSYS
-] HOUSING.PRT
Fe-[ ) BLLY_INSTLL.FRT
[ BLLY_INSTLL.PRT
[-+[ ] BLLY_INSTLL.PRT
[0 BLLY_INSTLL.PRT
[#-[1 BLLY_INSTLL.PRT
([ BLLY_INSTLL.PRT
[ (] HOUSINGZ PRT
(-] SEAL.FRT

[+ PISTOM.PRT

----- & Insert Here

Clipping Sate A

Instz nes RELIEF- W ALME IRIST

<= LE R

‘D%%%‘Qﬁ.\

Srmart

L«
oo

e

L
[

R




